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Subject: Computer

Duration (Periods): 2

Lesson Name: Memory of a Computer

Overview: A computer can store instructions to perform tasks.

Prior Knowledge: The students are aware of the basic functioning of a computer.

Learning Outcomes:
At the end of the lesson, the student will be able to: 

	• differentiate between types of computer memory.

	• state the measuring units for computer memory.

Teaching Aids: 
	• https://i.pinimg.com/564x/3b/44/c2/3b44c25592c586bcfdd35172d74dffce.jpg

	• https://i.pinimg.com/originals/0c/08/0a/0c080a277a051ea0d99a4bbdb633f76f.jpg 

Learning Segments:

LESSON LINK
Time: 05 minutes

Purpose: Brief 
introduction/discussion to 
pique students’ interest.

Greet the class and introduce the topic:   
	• The storage space of a computer is known as 

memory.
	• There are two types of memory: primary and 

secondary memory.

LESSON EXECUTION
Time: 25 minutes

Purpose: Engagement of 
both teacher and students 
to achieve the learning 
outcomes.

Period 1
	• Explain the difference between primary and 

secondary memory.
	• Discuss the types of storage devices such as 

Magnetic disk, Optical disc and Flash drive.
	• Explain how the memory of a computer is measured.

Period 2
	• Read out the rubrics in the Skill Drill section and 

encourage the students to indulge in the task 
individually.

	• Ensure that each student has completed the task.

LESSON CLOSURE
Time: 05 minutes

Purpose: Summarising the 
key points and reinforcing 
the learning outcomes of 
the lesson.

	• Discuss the answers to the questions.
	• Recapitulate the topics discussed in the lesson.

1.  Memory of a Computer
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DigiVerse 44

Answer Key [Chapter 1]

A.	 Tick () the correct option.
1.	 c. permanent		  2.	 a. Blu-ray disc		  3.	 b. flash		  4.  c. Primary
5.	 a. Magnetic Disk

B.	 Fill in the blanks using the words in the box.
1.	 Pen drive		  2.	 Memory card		  3.  nibble			   4.  bytes
5.	 DVD

C.	 Write T for True and F for False statements.
1.	 T		  2.	 T			   3.  F			   4.  T
5.	 T

D.	 Answer the questions in a few words.
1.	 The main memory of the computer is known as the primary memory.
2.	 A CD can hold up to 700 MB of data.
3.	 The three types of secondary memory are: Magnetic Disk, Optical Disc and Flash 

Drive.
4.	 1 Yottabyte has 1024 Zettabytes.
5.	 RAM is also known as volatile or temporary memory.

E.	 Answer the following questions.
1.	 The computer memory is measured in bytes. One byte is a collection of eight bits, for 

example, 01010101. A group of four bits is called nibble, example, 1101. We can also 
measure the memory of a computer in kilobytes, megabytes, gigabytes, terabytes, etc.

2.	 RAM, also known as volatile or temporary memory, temporarily stores data that 
is currently in use. Any data stored in RAM is stored only as long as the computer 
remains powered ON, and it is lost when the computer is powered OFF.

3.	 The difference between a CD and a DVD is:
•	 A compact disc (CD) is a portable storage device for storing, playing or recording 

data in a digital format. It can hold up to 700 MB of data.
•	 A DVD also works in a similar way to a CD but it has a greater capacity to store 

information or data compared to a CD.
4.	 A hard disk uses magnetic storage to store data and is permanently integrated 

into the computer system, It consists of a top and bottom surface where the data 
is recorded using a magnetic head. Hard disks are used for storing programs and 
data files.

5.	 Flash drive is a storage device that uses flash memory. There are two types of flash 
drives:
•	 A pen drive is a portable storage device that is small in size and is user-friendly. 

It can store a large amount of data. It can easily be connected to any computer 
via a USB port.

•	 A memory card is a compact and flat storage device used for storing various 
media and data files. It is commonly used in cameras and mobile phones.
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Subject: Computer

Duration (Periods): 2

Lesson Name: Working on Windows 10

Overview: Windows 10 is an operating system.

Prior Knowledge: The students have basic knowledge about system software.

Learning Outcomes:
At the end of the lesson, the student will be able to: 

	• identify and define various components of the Windows 10 desktop.

	• define the meaning of files and folders. 

Teaching Aids: 
	• https://edu.gcfglobal.org/en/windows10/windows-10-features/1/ 

	• https://www.customguide.com/cheat-sheet/windows-10-quick-reference.pdf 

Learning Segments:

LESSON LINK
Time: 05 minutes

Purpose: Brief 
introduction/discussion to 
pique students’ interest.

Greet the class and introduce the topic:
	• Windows 10 uses a user-friendly Graphical User 

Interface (GUI).
	• It allows running multiple programs simultaneously.

LESSON EXECUTION
Time: 25 minutes

Purpose: Engagement of 
both teacher and students 
to achieve the learning 
outcomes.

Period 1
	• Explain the meaning of an operating system.
	• Point out and explain the components of Windows 10 

desktop.
	• Explain the meaning of a file and folder.
	• Demonstrate the method of creating, copying, 

moving and deleting a file/folder.
	• Discuss the purpose of a Recycle Bin.

Period 2
	• Read out the rubrics in the Skill Drill section and 

encourage the students to indulge in the task 
individually.

	• Ensure that each student has completed the task.

2.  Working on Windows 10
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LESSON CLOSURE
Time: 05 minutes

Purpose: Summarising the 
key points and reinforcing 
the learning outcomes of 
the lesson.

	• Discuss the answers to the questions.
	• Recapitulate the topics discussed in the lesson.

Answer Key [Chapter 2]

A.	 Tick () the correct option.
1.	 b. Taskbar		  2.	 c. Recycle Bin		  3.  a. Icons			   4.  b. live tiles

B.	 Fill in the blanks using the words in the box.
1.	 directory		  2.	 file			   3.  Start			   4.  Copying

C.	 Write T for True and F for False statements.
1.	 T		  2.	 F			   3.  T			   4.  F

D.	 Answer the questions in a few words.
1.	 The keyboard shortcut to copy is Ctrl + C.
2.	 A file is a container for data and information stored on devices such as hard disks,  

USB drives, etc.
3.	 GUI stands for Graphical User Interface.
4.	 The Delete command is located on the Home tab.

E.	 Answer the following questions.
1.	 The steps to add a tile are:

•	 Click on the Start menu.
•	 Scroll to the name of the app or program. Right-click on the app you want to 

add to the Start menu.
•	 Select Pin to Start option. The selected app will appear as a live tile.

2.	 A folder is a group of files, it can hold several sub-folders as well.
3.	 The steps to move a file/folder are:

•	 In the File Explorer, browse to the location of the file/folder which you wish to 
move.

•	 Select the file/folder that you wish to move.
•	 Click on the Home tab.
•	 Click on Cut command from the Clipboard group.
•	 Select the destination location/folder where you wish to move the file/folder.
•	 Click on the Paste command from the Clipboard group. The file/folder is moved 

to the new location.
4.	 When we press the computer’s power button, it signals the RAM to initiate the 

operating system. This process is called booting.
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Subject: Computer

Duration (Periods): 2

Lesson Name: Features of Word 2016

Overview: We can create text documents in Word 2016.

Prior Knowledge: The students have basic knowledge of Word 2016.

Learning Outcomes:
At the end of the lesson, the student will be able to: 

	• draw shapes in a document.

	• insert WordArt and pictures in a document.

	• insert a table in the document. 

Teaching Aids: 
	• https://i.pinimg.com/originals/92/93/80/9293806d248e97daaa21f8eba67da08b.jpg 

	• https://www.youtube.com/watch?v=QbbprkeJbLM 

Learning Segments:

LESSON LINK
Time: 05 minutes

Purpose: Brief 
introduction/discussion to 
pique students’ interest.

Greet the class and introduce the topic:
	• In Word 2016, there are two graphic options, Drawing 

Objects and Pictures.
	• There are different options that we can use to 

customise any Word document.

LESSON EXECUTION
Time: 25 minutes

Purpose: Engagement of 
both teacher and students 
to achieve the learning 
outcomes.

Period 1
	• Demonstrate the method to add shapes.
	• Discuss the various ways to customise a shape such as 

inserting text, changing outline colour and thickness 
of a shape.

	• Explain the meaning of WordArt.
	• Demonstrate the method to insert pictures from the 

device or from the Internet.
	• Discuss the steps to insert a table and different ways 

to format it.

Period 2
	• Read out the rubrics in the Skill Drill section and 

encourage the students to indulge in the task 
individually.

	• Ensure that each student has completed the task.

3.  Features of Word 2016
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LESSON CLOSURE
Time: 05 minutes

Purpose: Summarising the 
key points and reinforcing 
the learning outcomes of 
the lesson.

	• Discuss the answers to the questions.
	• Recapitulate the topics discussed in the lesson.

Answer Key [Chapter 3]

A.	 Tick () the correct option.
1.	 b. Shift + Tab		  2.	 a. nine		  3.	 c. Column		  4.	 a. Table

B.	 Fill in the blanks using the words in the box.
1.	 Layout		  2.	 table		  3.	 Rows & Columns	 4.	 Design

C.	 Write T for True and F for False statements.
1.	 F		  2.	 T		  3.	 F		  4.	 F

D.	 Answer the questions in a few words.
1.	 The Online Pictures command is used to insert a picture from the Internet.
2.	 The Split Cells command is located in the Merge group.
3.	 The Merge Cells command is located in the Layout tab.
4.	 We select the Add Text option to insert text in a shape.

E.	 Answer the following questions.
1.	 The steps to draw a shape are:

•	 Click on the Insert tab.
•	 Click on the Shapes command in the Illustrations group. A drop-down list will 

appear from which you can insert a shape in the document.
•	 Choose any shape that you want, by clicking on it.
•	 Drag the mouse pointer from one point and release the mouse pointer when 

you have created the desired size of the shape.
2.	 We can select a row or a column in the following ways:

•	 To select a row, place the cursor in a cell and click on it, to start selecting. Move 
the cursor sideways till the last cell that is to be selected.

•	 To select a column, place the cursor in a cell and click on it, to start selecting. 
Move the cursor downwards till the last cell that is to be selected.

•	 To select adjacent cells, click inside a cell and drag the mouse pointer over all 
the cells that are to be selected.

3.	 WordArt is a collection of artistic and creative text styles that we can add to our 
document to beautify it. Follow these steps to add WordArt:
•	 Click on the Insert tab.
•	 Click on the WordArt option from the Text group. A WordArt quick style gallery 

will appear in a drop-down menu.

Galaxy_DigiVerse_Book-4_TRM.indd   8Galaxy_DigiVerse_Book-4_TRM.indd   8 05-03-2024   12:04:2905-03-2024   12:04:29



Teacher’s Resource Manual 9

•	 Choose a text style from the menu. A textbox will appear.
•	 Type something in the textbox. The text will appear in the selected WordArt 

style.
4.	 The steps to insert online picture in a document are:

•	 Click on the Insert tab. 
•	 Click on the Online Pictures option in the Illustrations group.
•	 The Insert Pictures dialog box will appear. Type a word in the Bing Image search 

box.
•	 Online Pictures dialog box will appear. Select the picture that you want to add 

to your document.
•	 Click on the Insert option. The picture will be added to the document.

4.  Using PowerPoint 2016

Subject: Computer

Duration (Periods): 2

Lesson Name: Using PowerPoint 2016

Overview: PowerPoint is an application designed for creating presentations.

Prior Knowledge: The students known the meaning of a presentation.

Learning Outcomes:
At the end of the lesson, the student will be able to: 

	• start PowerPoint.

	• create and save presentations.
	• view slide shows. 

Teaching Aids: 
	• https://www.youtube.com/watch?v=gkNGtBlZOwo 

	• https://slideswith.com/blog/interactive-powerpoint-activities-your-students-will-love

Learning Segments:

LESSON LINK
Time: 05 minutes

Purpose: Brief 
introduction/discussion to 
pique students’ interest.

Greet the class and introduce the topic:   
	• We can use PowerPoint to create presentations.
	• A presentation consists of a sequence of slides or 

pages on a specific topic.
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LESSON EXECUTION
Time: 25 minutes

Purpose: Engagement of 
both teacher and students 
to achieve the learning 
outcomes.

Period 1
	• Explain the meaning of a presentation.
	• Point out and explain the components of the 

PowerPoint window.
	• Demonstrate the method of creating a presentation.
	• Discuss the purpose of a slide show.
	• Demonstrate the method of saving a presentation.

Period 2
	• Read out the rubrics in the Skill Drill section and 

encourage the students to indulge in the task 
individually.

	• Ensure that each student has completed the task.

LESSON CLOSURE
Time: 05 minutes

Purpose: Summarising the 
key points and reinforcing 
the learning outcomes of 
the lesson.

	• Discuss the answers to the questions.
	• Recapitulate the topics discussed in the lesson.

Answer Key [Chapter 4]

A.	 Tick () the correct option.
1.	 c. presentations	 2.	 b. Zoom Slider	 3.	 a. Slide Show		  4.  c. Slides
5.	 b. Ribbon

B.	 Fill in the blanks using the words in the box.
1.	 slides		  2.	 placeholder		 3.	 Subtitle			   4.  Close
5.	 Status

C.	 Write T for True and F for False statements.
1.	 T		  2.	 F		  3.	 T			   4.  F
5.	 T

D.	 Answer the questions in a few words.
1.	 Save, Undo, Redo and Slideshow commands are present on the Quick Access Toolbar.
2.	 The Backstage view is a feature to perform several actions related to presentations 

such as saving, sharing, printing, etc.
3.	 The Slides pane displays the thumbnail for each slide.
4.	 Tabs and Groups are components of the ribbon in Microsoft PowerPoint. Each tab 

has a set of commands that are given as tool buttons.
5.	 A placeholder is a box with a dotted outline. We can add text/pictures/videos in a 

placeholder.
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E.	 Answer the following questions.
1.	 A presentation is a collection of slides. A slide is known as a page of the presentation 

that contains text/pictures/videos. The steps to create a new presentation are:
•	 Click on the File tab. 
•	 Click on Blank Presentation in the Backstage View. A new presentation will 

appear with a blank side.
2.	 The steps to add title are:

•	 Click on the Title Text Placeholder box.
•	 Type the text in the text placeholder box. The text will appear in the Title Text 

Placeholder and the Slides tab as well.
3.	 A slide show is a view in which the presentation is displayed in full-screen mode, 

allowing us to preview how it will appear to the audience. The steps to view a slide 
show are:
•	 Click on the Slide Show tab in the ribbon.
•	 Click on From Beginning in the Start Slide Show group.
	 Or, you can click on the Slide Show icon on the Status bar. Slide show of the 

current slide can be viewed by pressing the F5 key.
4.	 The steps to add a new slide are:

•	 Click on the Home tab.
•	 Click on the New Slide command in the Slides group.
•	 Select the type of slide that you want to add. A new slide will be inserted.
	 Or, a new slide can be inserted by right-clicking in the Slides pane. Select the 

New Slide option from the pop-up menu.
5.	 The steps to save a presentation are:

•	 Click on the File tab. The Backstage view will appear.
•	 Click on the Save As button or click on the Save button on the Quick Access 

Toolbar.
•	 Go to the folder or location in which you want to save the file.
•	 Click on the File Name text box and type a name for the file.
•	 Click on Save. PowerPoint 2016 will save the presentation.

5.  Internet

Subject: Computer

Duration (Periods): 2

Lesson Name: Internet

Overview: The Internet is a means to exchange data and information among computers.

Prior Knowledge: The students are aware of web browsers.
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Learning Outcomes:
At the end of the lesson, the student will be able to: 

	• understand the meaning of Internet and Internet terms.

	• use a search engine to search for any information.

Teaching Aids: 
	• https://i.pinimg.com/originals/cb/68/6e/cb686e282af707e59f4d4ec7e8dd6181.jpg 

	• https://i.pinimg.com/564x/34/87/ca/3487ca301d75fbce15eb1e52d6a63137.jpg 

Learning Segments:

LESSON LINK
Time: 05 minutes

Purpose: Brief 
introduction/discussion to 
pique students’ interest.

Greet the class and introduce the topic:
	• The Internet comprises a vast network connecting 

millions of computers worldwide.
	• Internet is also known as a network of networks.

LESSON EXECUTION
Time: 25 minutes

Purpose: Engagement of 
both teacher and students 
to achieve the learning 
outcomes.

Period 1
	• Explain the meaning of Internet.
	• Discuss the history of Internet.
	• Explain the terms related to Internet.
	• Demonstrate the method of using a web browser.
	• Point out and explain the components of Microsoft 

Edge window.

Period 2
	• Read out the rubrics in the Skill Drill section and 

encourage the students to indulge in the task 
individually.

	• Ensure that each student has completed the task.

LESSON CLOSURE
Time: 05 minutes

Purpose: Summarising the 
key points and reinforcing 
the learning outcomes of 
the lesson.

	• Discuss the answers to the questions.
	• Recapitulate the topics discussed in the lesson.

Answer Key [Chapter 5]

A.	 Tick () the correct option.
1.	 b. home page		  2.	 c. hyperlink		  3.	 a. Home Page	 4.	 a. Favorites
5.	 c. Back
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B.	 Fill in the blanks using the words in the box.
1.	 Website		  2.	 Internet		  3.	 Search engine	 4.	 World Wide Web
5.	 Refresh

C.	 Write T for True and F for False statements.
1.	 F		  2.	 F		  3.	 F	 4.	 T
5.	 F

D.	 Answer the questions in a few words.
1.	 ISP stands for Internet Service Provider.
2.	 Each website on the Internet has a unique address. This is known as the Uniform 

Resource Locator (URL) of the website.
3.	 A search engine is a software that enables the user to search for information on 

the Internet. 
4.	 The company that provides us with an Internet connection is called the Internet 

Service Provider. Examples include Airtel, Jio, BSNL, MTNL, Vodafone Idea (Vi), etc.
5.	 We can open multiple websites in separate tabs simultaneously. The tab that we 

are actively using is called the ‘current tab’ and it is displayed in light grey, while 
the other open tabs are displayed in a darker grey colour. 

E.	 Answer the following questions.
1.	 Downloading is when the user saves any data from the Internet such as games, 

software, movies or music and keeps it on the computer to use it without being 
online.

2.	 The default web browser in Windows 10 operating system is Microsoft Edge. The 
steps to open Microsoft Edge are:
•	 Click on the Start button.
•	 Type Microsoft Edge in the search box.
•	 Click on Microsoft Edge. The application will open.

3.	 When the technology was limited, scientists needed computers for research but 
they didn’t have enough computers. So, they created a network called ARPANET 
(Advanced Research Projects Agency Network) or ARPA. As more computer joined 
this network, it grew, eventually becoming the Internet.

4.	 Components of the Microsoft Edge window are:
•	 Back/Next: We use the Back button to return to the previous page and the Next 

button to visit the next page.
•	 Refresh: We can reload a page by clicking on the Refresh button.
•	 Favorites: We use the Favorites button to save a website or a web page that 

we like.
•	 More: With the More button, we can access more features such as Private Mode, 

Zoom, Print and additional settings.
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5.	 The steps to use a search engine are:
•	 Open any web browser.
•	 Open any search engine such as Google.
•	 In the search box, type the keywords to search.
•	 Press the Enter key or click on the Search button. You will see many search 

results in the form of websites.
•	 Click on the website that you want visit and read the information from.

6.  Visual Processing

Subject: Computer

Duration (Periods): 2

Lesson Name: Visual Processing

Overview: We can improve our analysis and critical thinking skills by solving puzzles.

Prior Knowledge: The students are aware of puzzles and maps.

Learning Outcomes:
At the end of the lesson, the student will be able to: 

	• solve picture puzzles.

	• understand coordinates.

Teaching Aids: 
	• https://i.pinimg.com/564x/1f/42/63/1f4263a3c405389844ae643e17f3c2fb.jpg 

	• https://i.pinimg.com/564x/54/05/ee/5405ee3cd740871cc8debaf942671dc8.jpg 

Learning Segments:

LESSON LINK
Time: 05 minutes

Purpose: Brief 
introduction/discussion to 
pique students’ interest.

Greet the class and introduce the topic:
	• Visual processing refers to our ability to store and 

process visual information around us.
	• We can solve puzzles and find coordinates through 

visual processing.

LESSON EXECUTION
Time: 25 minutes

Purpose: Engagement of 
both teacher and students 
to achieve the learning 
outcomes.

Period 1
	• Explain the meaning of visual processing.
	• Discuss the different types of picture puzzles.
	• Explain the meaning of maps and coordinates.

Period 2
	• Read out the rubrics in the Skill Drill section and 

encourage the students to indulge in the task 
individually.

	• Ensure that each student has completed the task.
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LESSON CLOSURE
Time: 05 minutes

Purpose: Summarising the 
key points and reinforcing  
the learning outcomes of  
the lesson.

	• Discuss the answers to the questions.
	• Recapitulate the topics discussed in the lesson.

Answer Key [Chapter 6]

A.	 Circle the odd one each set.
1.	 				    2.	 		

3.	 				    4.	

B.	 Write the coordinates as per the Treasure Map.
1.	 D5		  2.	 E2		  3.	 C2		  4.	 B3
5.	 D1

Subject: Computer

Duration (Periods): 2

Lesson Name: Blocks in Scratch

Overview: Scratch software is used for creating different games.

Prior Knowledge: The students are aware of computer games.

Learning Outcomes:
At the end of the lesson, the student will be able to: 

	• identify various components of the Scratch window.

	• state the different block categories in Scratch.
	• create different projects. 

Teaching Aids: 
	• https://www.spiceworks.com/tech/devops/articles/scratch-coding/

	• https://i.pinimg.com/564x/58/7f/ff/587fff3619adf9f817045a8dbf926a42.jpg

7.  Blocks in Scratch
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Learning Segments:

LESSON LINK
Time: 05 minutes

Purpose: Brief 
introduction/discussion to 
pique students’ interest.

Greet the class and introduce the topic:
	• We can use the Scratch software to create different 

games.
	• Scratch 3.0 is the latest version of Scratch.

LESSON EXECUTION
Time: 25 minutes

Purpose: Engagement of 
both teacher and students 
to achieve the learning 
outcomes.

Period 1
	• Point out and explain the components of the Scratch 

window.
	• Discuss the different block categories in Scratch.
	• Demonstrate the method of setting the Sprite 

position.
	• Encourage the students to create various programs in 

Scratch.

Period 2
	• Read out the rubrics in the Skill Drill section and 

encourage the students to indulge in the task 
individually.

	• Ensure that each student has completed the task.

LESSON CLOSURE
Time: 05 minutes

Purpose: Summarising the 
key points and reinforcing 
the learning outcomes of 
the lesson.

	• Discuss the answers to the questions.
	• Recapitulate the topics discussed in the lesson.

Answer Key [Chapter 7]

A.	 Tick () the correct option.
1.	 b. Scratch		  2.	 c. Looks		  3.	 a. Looping		  4.	 b. Events
5.	 c. magenta

B.	 Fill in the blanks using the words in the box.
1.	 x and y		  2.	 Control		  3.	 Motion		  4.	 purple
5.	 Events

C.	 Write T for True and F for False statements.
1.	 T		  2.	 T		  3.	 F		  4.	 F
5.	 F
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D.	 Answer the following questions.
1.	 The position of Sprite on the stage can be set by changing the values of the x and 

y coordinates. The x value denotes the horizontal position from left to right. The 
y value denotes the vertical position, from top to bottom.

2.	 Scratch has various categories for blocks. In these blocks, we can change the value 
according to the script. The different block categories are Motion, Looks, Sound, 
Events, Control, Sensing, Operators and My Blocks.

3.	 The amber coloured blocks in Scratch that are used to control the scripts under certain 
conditions are called control blocks. Some examples of control blocks are forever, 
repeat, etc.

4.	 We can manage the sound functions by using the sound blocks. These blocks are 
magenta in colour.

5.	 The blocks that are used to add speech and thought bubbles to the Sprite are 
called looks blocks. They are purple in colour. Examples of looks blocks are say, 
think, etc.

Subject: Computer

Duration (Periods): 2

Lesson Name: Shapes in Scratch

Overview: Scratch software is used for creating different games.

Prior Knowledge: The students have basic knowledge of Scratch.

Learning Outcomes:
At the end of the lesson, the student will be able to: 

	• add the Pen extension to the blocks category.

	• use the Pen blocks to create different shapes in Scratch.

Teaching Aids: 
	• https://i.pinimg.com/564x/cf/e4/aa/cfe4aac024e568882a173f291a199dce.jpg 

	• https://scratch.mit.edu/projects/939262439/

Learning Segments:

LESSON LINK
Time: 05 minutes

Purpose: Brief 
introduction/discussion to 
pique students’ interest.

Greet the class and introduce the topic:
	• We can use the Scratch software to create different 

games.
	• We use the Pen extension to make shapes in Scratch.

8.  Shapes in Scratch
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LESSON EXECUTION
Time: 25 minutes

Purpose: Engagement of 
both teacher and students 
to achieve the learning 
outcomes.

Period 1
	• Explain the meaning of Pen block.
	• Demonstrate the usage of Pen block.
	• Demonstrate the method of drawing shapes in 

Scratch.
	• Encourage the students to create various shapes in 

Scratch.

Period 2
	• Read out the rubrics in the Skill Drill section and 

encourage the students to indulge in the task 
individually.

	• Ensure that each student has completed the task.

LESSON CLOSURE
Time: 05 minutes

Purpose: Summarising the 
key points and reinforcing 
the learning outcomes of 
the lesson.

	• Discuss the answers to the questions.
	• Recapitulate the topics discussed in the lesson.

Answer Key [Chapter 8]

A.	 Tick () the correct option.
1.	 b. 4	 2.	 a. sides
3.	 c. angle	 4.	 c. Full Screen Control button

B.	 Write T for True and F for False statements.
1.	 F		  2.	 T		  3.	 T		  4.	 F

C.	 Answer the following questions.
1.	 The Pen block is a tool to draw shapes in Scratch. These blocks are green in colour. 
2.	 Polygons are closed 2D figures which are made up of only lines and no curves.
3.	 The rules to be followed while making a polygon are:

•	 Number of sides: Recognise the number of sides of the shape that is to be 
created. Specify the sides in the repeat block.

•	 Drawing a line: Every time the repeat command is used, a line has to be drawn, 
along with a turn at the corner.

•	 Degree of angle: For each shape, we calculate the degree of angle at which 
the corners will be created. We can calculate the degree by dividing 360 by the 
number of sides there are in the shape.
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9.  History of AI

Subject: Computer

Duration (Periods): 2

Lesson Name: History of AI

Overview: AI has evolved over the years, leading to advancement in many ways.

Prior Knowledge: The students are aware of Artificial Intelligence (AI).

Learning Outcomes:
At the end of the lesson, the student will be able to:

	• understand the concept of Artificial Intelligence (AI).

	• categorise the evolution of AI into different decades.

Teaching Aids:
	• https://www.techtarget.com/searchenterpriseai/definition/AI-Artificial-Intelligence

	• https://www.thats-ai.org/en-GB/units/a-brief-history-of-ai

Learning Segments:

LESSON LINK
Time: 05 minutes

Purpose: Brief 
introduction/discussion to 
pique students’ interest.

Greet the class and introduce the topic:
	• AI means making computers do smart things that 

usually require human-like thinking.
	• AI can be specialised for a job or it can be versatile.

LESSON EXECUTION
Time: 25 minutes

Purpose: Engagement of 
both teacher and students 
to achieve the learning 
outcomes.

Period 1
	• Explain the meaning of Artificial Intelligence (AI).
	• Discuss the birth of AI.
	• Discuss the different phases of advancement of AI 

from expert systems to data-driven AI.
	• Also, discuss the ongoing advancements in AI.

Period 2
	• Read out the rubrics in the Skill Drill section and 

encourage the students to indulge in the task 
individually.

	• Ensure that each student has completed the task.

LESSON CLOSURE
Time: 05 minutes

Purpose: Summarising the 
key points and reinforcing 
the learning outcomes of 
the lesson.

	• Discuss the answers to the questions.
	• Recapitulate the topics discussed in the lesson.
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Answer Key [Chapter 9]

A.	 Tick () the correct option.
1.	 a. Roomba		  2.	 c. 1980		  3.	 a. Watson		  4.	 b. Bombe

B.	 Fill in the blanks using the words in the box.
1.	 AlphaGo		  2.	 John McCarthy	 3.	 WABOT		  4.	 i-robot

C.	 Write T for True and F for False statements.
1.	 T		  2.	 F		  3.	 T		  4.	 T
5.	 T

D.	 Answer the following questions.
1.	 Artificial Intelligence means making computers do smart things that usually 

require human-like thinking, like learning from data, understanding language 
and making choices.

2.	 In 1950, Alan Turing created a test known as the Imitation Game and later it was 
known as the Turing Test. He created a machine called the Bombe. This machine 
could decode the encoded messages.

3.	 Symbolic AI refers to organising knowledge logically, using rules and symbols.
4.	 In the 1980s and 1990s, machine learning became more significant. Researchers 

created algorithms which let machines learn from data and make predictions. 
In 1980, WABOT 2 was created. It was capable of playing a piano. In the year 
1997, the chess grandmaster Garry Kasparov was defeated by the computer 
chess-playing expert system Deep Blue.

5.	 AI keeps getting better and is used in many areas such as self-driving cars, healthcare and 
robot. In 2011, IBM’s Watson won the game show “Jeopardy!” against human champions 
which showed that AI can understand human language and handle lots of information.  
In 2016, DeepMind’s AlphaGo beat the world champion of the ancient game Go, 
Lee Sedol. This was a big achievement for AI because Go is a complex game with 
many possible moves, making it a tough challenge for AI.

Worksheet 1

A.	 Define the following.
1.	 Random Access Memory (RAM) is also known as volatile or temporary memory. 

It temporarily stores the data that is currently in use. Any data stored in RAM is 
stored only as long as the computer remains powered ON. 

2.	 Shortcuts to applications are known as live tiles.
3.	 WordArt is a collection of creative and artistic text styles that we can add to our 

document to beautify it.
4.	 A magnetic disk is storage device that uses the process of magnetisation for reading, 

writing and retrieving data. It has a magnetic coating on both sides, allowing data 
to be written, rewritten or erased multiple times as needed.

5.	 Icons are small pictures with names that stand for programs, folders and files on 
the computer. They are shortcuts to quickly open the file, folder and application. 
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B.	 Write the steps in brief.
1.	 Start > drop-down menu > More > Pin to taskbar
2.	 Insert > Pictures > location > Insert
3.	 This PC > Home > New folder
4.	 Insert > Table > Insert Table > OK
5.	 File Explorer > Home > Copy > Paste

Worksheet 2

A.	 Define the following.
1.	 A hyperlink is a link that holds data or information, allowing the user to access it 

by clicking on it.
2.	 A ribbon consists of tabs and groups. Each tab has a set of commands that are 

given as tool buttons.
3.	 A slide is known as a page of the presentation that contains text/pictures/videos.
4.	 The company that provides us with an Internet connection is called an Internet 

Service Provider (ISP).
5.	 A placeholder is a box with a dotted outline. We can add text/pictures/videos in 

a placeholder.

B.	 Write the steps in brief.
1.	 Slide Show > From Beginning
2.	 Start > type in search box > Microsoft Edge
3.	 Title Text Placeholder > Blank Presentation
4.	 Web Browser > Search Engine > type in search box > Search button
5.	 Home > Slide group > New Slide

Worksheet 3

A.	 Define the following.
1.	 Picture puzzle is a series of pictures that can be pieced together to form a complete 

picture.
2.	 We use Motion blocks to control the movement and position of Sprite on the stage. 

They are blue in colour.
3.	 Spot the difference puzzle are those puzzles in which we look at two similar pictures 

and find out the difference. It checks how closely we can pay attention to the details.
4.	 When we want to repeat the same block in a script for some time, we use the 

looping blocks found in control blocks.
5.	 Events blocks are the topmost blocks. These blocks run the script on the stage by 

controlling the execution of scripts. It gives you the control of all the blocks. No 
program can run in the absence of this block.

B.	 Application-based questions.
1.	 Sound block	 2.	 Spot the difference
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Worksheet 4

A.	 Define the following.
1.	 Pen block is used to draw shapes in Scratch. It is green in colour. 
2.	 Roomba is an autonomous robot vacuum that was released by iRobot in the year 

2002.
3.	 Artificial Intelligence means making computers do smart things that usually require 

human-like thinking, such as learning from data, understanding language and making 
choices.

4.	 Polygons are closed 2D figures which are made up of only lines and no curves.
5.	 In the year 1997, the chess grandmaster Garry Kasparov was defeated by the 

computer chess-playing expert system called Deep Blue. It was created by 
International Business Machines (IBM).

B.	 Application-based questions.
1.	 Events block	 2.	 Full Screen Control button

Test Paper 1

A.	 Tick () the correct option.
1.	 c. Primary		  2.	 b. live tiles		  3.	 c. column		  4.	 c. Slides
5.	 c. Back

B.	 Fill in the blanks.
1.	 Memory card		  2.	 directory		  3.	 Design		  4.	 Status
5.	 Website

C.	 Write T for True and F for False statements.
1.	 T		  2.	 F		  3.	 F		  4.	 T
5.	 T

D.	 Answer the questions in a few words.
1.	 A CD can hold up to 700 MB of data.
2.	 GUI stands for Graphical User Interface.
3.	 We select the Add Text option to insert text in a shape.
4.	 The Backstage view is a feature to perform several actions related to presentations 

such as saving, sharing, printing, etc.
5.	 A search engine is a software that enables the user to search for information on 

the Internet.

E.	 Answer the following questions.
1.	 The computer memory is measured in bytes. One byte is a collection of eight bits, 

for example, 01010101. A group of four bits is called nibble, example, 1101. We 
can also measure the memory of a computer in kilobytes, megabytes, gigabytes, 
terabytes, etc.

Galaxy_DigiVerse_Book-4_TRM.indd   22Galaxy_DigiVerse_Book-4_TRM.indd   22 05-03-2024   12:04:3005-03-2024   12:04:30



Teacher’s Resource Manual 23

2.	 When we press the computer’s power button, it signals the RAM to initiate the 
operating system. This process is called booting.

3.	 WordArt is a collection of artistic and creative text styles that we can add to our 
document to beautify it. Follow these steps to add WordArt:
•	 Click on the Insert tab.
•	 Click on the WordArt option from the text group. A WordArt quick style gallery 

will appear in a drop-down menu.
•	 Choose a text style from the menu. A textbox will appear.
•	 Type something in the textbox. The text will appear in the selected WordArt 

style.
4.	 A Slide Show is a view in which the presentation is displayed in full-screen mode, 

allowing us to preview how it will appear to the audience. Follow these steps to 
view a slide show:
•	 Click on the Slide Show tab in the ribbon.
•	 Click on From Beginning in the Start Slide Show group.
	 Or, you can click on the Slide Show icon on the status bar. Slide show of the 

current slide can be viewed by pressing the F5 key.
5.	 Components of the Microsoft Edge window are:

•	 Back/Next: We use the Back button to return to the previous page and the Next 
button to visit the next page.

•	 Refresh: We can reload a page by clicking on the Refresh button.
•	 Favorites: We use the Favorites button to save a website or a web page that 

we like.
•	 More: With the More button, we can access more features such as Private Mode, 

Zoom, Print and additional settings.

Test Paper 2

A.	 Tick () the correct option.
1.	 a. Looping		  2.	 a. sides		  3.	 b. Bombe		  4.	 a. Scratch
5.	 c. 1980

B.	 Fill in the blanks.
1.	 x and y		  2.	 Control		  3.	 WABOT		  4.	 AlphaGo
5.	 purple

C.	 Write T for True and F for False statements.
1.	 F		  2.	 T		  3.	 F		  4.	 T
5.	 T

D.	 Answer the questions in a few words.
1.	 Sound blocks are magenta in colour.
2.	 The ‘select the odd one out’ puzzle is where we find the one item that does not 

belong in a group based on specific rules or criteria. 
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3.	 A picture puzzle can be defined as a series of pictures that can be pieced together 
to form a complete picture.

4.	 Artificial intelligence means making computers do smart things that usually require 
human-like thinking.

5.	 John McCarthy is known as the ‘Father of AI’.

E.	 Answer the following questions.
1.	 The amber coloured blocks in Scratch that are used to control the scripts under 

certain conditions are called control blocks. Repeat and forever blocks are examples 
of control blocks.

2.	 In the 1980s and 1990s, machine learning became more significant. Researchers 
created algorithms which let machines learn from data and make predictions. In 
1980, WABOT 2 was created. It was capable of playing a piano. In the year 1997, 
the chess grandmaster Gary Kasparov was defeated by the computer chess-playing 
expert system Deep Blue.

3.	 The rules to be followed while making a polygon are:
•	 Number of sides: Recognise the number of sides of the shape that is to be 

created. Specify the sides in the repeat block.
•	 Drawing a line: Every time the repeat command is used, a line has to be drawn, 

along with a turn at the corner.
•	 Degree of angle: For each shape, we calculate the degree of angle at which 

the corners will be created. We can calculate the degree by dividing 360 by the 
number of sides there are in the shape.

4.	 Pen block is used to draw shapes in Scratch. It is green in colour.
5.	 AI keeps getting better and is used in many areas such as self-driving cars, healthcare and 

robot. In 2011, IBM’s Watson won the game show “Jeopardy!” against human champions 
which showed that AI can understand human language and handle lots of information.  
In 2016, DeepMind’s AlphaGo beat the world champion of the ancient game Go, 
Lee Sedol. This was a big achievement for AI because Go is a complex game with 
many possible moves, making it a tough challenge for AI.

1.  d.	 2.  b.	 3.  b.	 4.  d.	 5.  a. 

6.  a. 	 7.  a.	 8.  a.	 9.  d.	 10.  c. 

National Cyber Olympiad
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